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“Asgaard” 
Photo by Bill Jochimsen 

__________________________________________________________________________________________ 
ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not looked the way you 

expected? The problem is probably a difference in how your computer and the club projector display colors and 

brightness. You can fix this by calibrating your computer the same way our club calibrates our projector – with the 

ColorMunki. Set up is simple and the calibration process only takes a few minutes. Contact Carl Detrow at 

csdetrow@verizon.net  to reserve the ColorMunki. 
__________________________________________________________________________________________ 

Puppy and Kitty Portraits Help Shelter Pets Find New Homes 
 
 

RCC Member Debra Dorothy helps shelter pets find new homes by taking 
portraits of them. The photos of these furry creatures were taken at the 
Redlands Animal Shelter. If you would like to adopt an animal please call 
the Redlands Animal Shelter at 

(909) 798-7644 
Want to learn more about your hobby?  

                           Click the link below to go to B&H learning Video Site: 

Click HERE

mailto:csdetrow@verizon.net
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017
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Field Trips – Mary Ann Ponder  
  

 January Field Trip 
 

This field trip has got it all…cacti, canyons, mid-century modern architecture, 

retro hotels and Over the Rainbow cupcakes. Join us Tuesday, January 14th on 

a road trip to Palm Springs. We will visit the Moorten Botanical Garden, 1701 

South Palm Canyon Drive. Admission $5 per person. This private arboretum 

contains a wide variety of desert plants and serves as a popular wedding 

venue. Although most cacti are not in bloom this time of year, there may be 

some flowering aloes to photograph. Tripods and models are allowed in the 

garden; however, there is an additional fee for commercial photographers. 

 

There are picnic tables in the garden if you wish to carry your lunch. Or we can go to the Smoke Tree 

Shopping Center, 1775 East Palm Canyon Drive, which is a short distance from the gardens. There are 

several restaurants in the courtyard to choose from including Smoke Tree BBQ, Native Foods Café, 533 

Viet Fusion and Over the Rainbow Cupcakes. 

 

We will also visit the Indian Canyons, 38520 South Palm Canyon Drive. Admission $9 adults/$7 seniors. 

Palm Canyon, Andreas Canyon and Murray Canyon are the ancestral home of the Agua Caliente Band of 

Cahuilla Indians and a scenic location for landscape photographers.  

 

A carpool will leave from the back of the parking lot at Coco’s Restaurant, 1140 West Colton Avenue in 

Redlands at 9:00AM and return to this location in the afternoon. Please contact Mary Ann Ponder at 

909-213-5108 or e-mail maponder@yahoo.com at least one day in advance of the outing if you wish to 

come. Monthly field trips are a benefit of Redlands Camera Club membership. There is no charge to 

members but sign-ups are required. 

 
 
 
 
 
 
 

 
Photo 

By 
Mary Ann Ponder 

 
 
 

 

mailto:maponder@yahoo.com
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Competition Chair – Carl Detrow 

Competitions 

 

What an inspiring competition! We had 56 entries from 28 members spanning all 

classes and categories. Thanks again to everyone who entered.  

 

The competition committee agreed that the comments from this judging trio was 

among the best and most useful we’ve had in a long time.  

 

Best of Show went to Ann Kramer for “Cellophane Wings.” Congratulations Ann!  

 

The committee met and discussed the judging which was consistent across all entries. None was 

extremely high or low. Of course no one will agree with every decision, but they were fair. The monitor 

and laptop they used for the judging were available at the awards night and members were able to see 

the images as the judges saw them.  

 

The judges seemed to agree that post processing is an important element in creation of photographic 

art, and all of them used it to some extent. However their comments showed that poor adjustments that 

detract from an image will result in reduced scores. More to follow. 

 

Our next competition will be Spring 2020 at the first meeting in March (March 2, 2020). I’m still looking 

for a category “X” for this one, so let me know if you have any suggestions. 

 
Contact me by email:  csdetrow@verizon.net 

 

 

 

 

Photo 
by 

Wayne “Woody” Wood 

 

 

 

 

 

mailto:csdetrow@verizon.net
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President’s Message – Russell Trozera 
 

Presidents Message 

I hope that everyone got what they were looking for this Christmas. This New Year will be exciting. We 

will all be able to see 2020. 

I hope that this year brings a lot of opportunities for all of our members to enjoy  what they like best 

about photography.  Photography takes me to places that I am awed by the beauty surrounding me.  

I am always motivated by a new year and the opportunities it presents, places to go and things to see. 

I was recently on the photoblog and saw some of our members enjoying  photography. What wonderful captures. Here are 

some wonderful quotes by other photographer and artist. 

Great Art picks up where Nature ends. Marc Chagall  

There is nothing worse than a sharp image of a fuzzy concept. Ansel Adams 

When I have a camera in my hand I know not fear   Alfred Eisenstaedt 

Not everybody trusts paintings but people believe photographs.   Ansel Adams 

History develops, art stands still.   E. M. Forster 

You don’t take a photograph, you make it.   Ansel Adams 

The purpose of art is washing the dust of daily life off our souls Pabla Picasso 

There are no rules for good photographs, there are only good photographs. Ansel Adams 

There are always two people in the picture: the photographer and the viewer. Ansel Adams 

A good photograph is knowing where to stand. Ansel Adams 

Twelve significant photographs in any one year is a good crop.  Ansel Adams 

Best Wishes to all the members of the Redlands Camera Club. 

 

 

“Lucina” 
 

Photo 
By 

Beverly Brett 
 
 

 



~ 5 ~ 
 

Program Chair- Russell Trozera  
 

Jan. 6, 2019 “Ansel Adams” night 

Doug Hammer will be speaking on insights into Ansel Adams. Doug was able to  

help and assist  Ansel Adams on several workshops.  

Jan. 20 2019 “John Williams” 

John Williams is an excellent speaker and has presented many tutorials on Lightroom and Photoshop 

in the Redlands Camera Club Newsletter.  He currently serves as our educational chair of the Club. He 

will be speaking on Adobe Ecco Systems, cloud systems Iphone & Photo systems.  

 Photography Bio – Doug Hammer 

I remember the first time I saw original black and white photographs by Ansel Adams 

– I was spellbound. The photographs were breathtaking. It was February 1971 and I 

was in the Ansel Adams Gallery in Yosemite. 

I was immediately drawn into the world of photography. I wanted to understand how 

such images could be created. I read and carefully studied Adams’ books The 

Camera, The Negative, and The Print. I built a darkroom. I built a 4x5 camera. I used 

Adams’ zone system. I tested camera settings, calculated exposures, and 

experimented with developers and darkroom techniques. 

In 1978 I was accepted as a student into the Ansel Adams Photography Workshop in Yosemite, financed with 

winnings on a TV show, Family Feud. In 1980 I was asked to serve as an assistant at Adams’ Workshop – again 

in Yosemite. And, in 1982, I was invited to serve as the technical assistant at Adams’ last Workshop held in 

Pebble Beach, CA. 

I moved out of the darkroom and into digital photography in 2004. Although I have a website, 

www.doughammerphotography.com, I still prefer looking at and making my own prints. 

Since that initial introduction to the world of photography in 1971, I have not lost the excitement of clicking the 

shutter and watching how art and science work 

together to capture such wonderful memories. 

I have been married to Judi 48 years; we are 

parents of four, grandparents of 10. My 

profession is management consulting and my 

formal education was at Pepperdine University 

with a B.S. in Management and a M.S. in 

Organization Development. 

“Honey” 
Photo by Carol Abidin 

 

http://www.doughammerphotography.com/
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S4C Chair – Deborah Seibly 
 

 

Members from the Redlands Camera Club did very well in the December 

competition, winning nine awards and honorable mentions.  

 

Three awards were earned by Christine Cope Pence. She earned an award in 

the category of Pictorial Monochrome (A) and two awards in the Nature 

Wildlife (E) category.  

 

Another award was earned by Jim Hendon for his entry in Photojournalism 

(E). 

 

Honorable mentions were given to Clay Hodson in the Pictorial Individual Color category (E), Jim 

Hendon in Nature Wildlife (E) and Deb Seibly for my entry into Photojournalism-Human Interest (A).  

 

I may not be able to get the actual photos ready for display for this current newsletter as I am away from 

my computer but will have them ready for next month. 

 

For the first time I entered one of my photos into the Pictorial Interclub competition representing the 

Redlands Camera Club and “we” earned an Honorable Mention.  

 

In the future, I would like to enter some of our best of show winners so I may be reaching out to you.   

 

Merry Christmas, Happy Holidays to all! 

 

 

 

 

 

Photo 
By 

Ronald Anderson 
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Here’s What I Think – John Williams 

 

Here’s What I Think! 

This article covers different Adobe 

Photoshop/Lightroomtips and techniques.  The views 

expressed in this article are those of the author and do 

not necessarily reflect the views of Redlands Camera 

Club. 

By John Williams 
Need help?  If you have any questions about processing an image using Adobe Lightroom or 

Photoshop, email me at jhwr@earthlink.net (for RCC members only) and I will try to assist you. 

PHOTOSHOP TIPS 

Quick Share: 

 The Quick Share button lets you instantly share either a full or low resolution version of the image to email, as well as a 

range of social media outlets and cloud services. 

 You can now email or share your creations to several services directly from within Photoshop.  When you share a 

document by email, Photoshop sends out the original document (.psd file).  For certain services and social media 

channels, Photoshop automatically converts the document to the JPEG format before sharing. 

 How to Share:Go to the far right side of the Options Barand click the Share button (see figure below) orchoose 

File>Share. 

 

o In the Share dialog panel (see figure below), choose whether you want to share the full-sized asset or a smaller 

version of it.  If you choose to share the smaller version, Photoshop scales down the document such that its longer 

edge is 1200 px long. The other edge is scaled down proportionately.  Click the service you wish to use.  For 

example, click Mail, Facebook, etc. 

 

mailto:jhwr@earthlink.net
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 In the Share dialog panel, you'll see various choices.  If you choose the Mail app option, you will get the following 

dialog: 

 

o In the To field, type an email address and depress the Send button located at the very top right of the Mail dialog 

window. 

Transform a Selection: 

 After making a selection you don’t need to start over to make a selection larger, smaller or distort/rotate/warp the 

selection. 

 If you choose Select>Transform Selection, this command places the same handles around the selection as Free 

Transform, but these handles affect the selection outline 

itself, not the pixels inside of selection. 

 Drag the handles to make the selection larger or smaller. 

 Drag a corner handle to adjust width and height 

simultaneously. 

 Hold down the Shift key and drag on a corner handle to 

size proportionally. 

 You can also place your cursor outside of one of the 

handles to rotate the selection (cursor turns into a 

double headed arrow). 

 If you right-click inside the marching ants, a popup menu 

will display giving sever options – Skew, Distort, Warp, etc.  

The Warp mode allows you to adjust the selection of 

irregular objects like an egg, which are very difficult to 

select especially when the background and object have similar colors.  

To adjust the selection, use the handles which will appear on each side 

of selected area.  The transform handles for the bounding box will move 

independently of each other. 

 Press Enter or double-click in the center of the selection area to confirm 

the transformation.   Press Esc to release the transformation and return 

to the original selection. 
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 Note:  You can Save the selection as an Alpha Channel.  After creating your selection (marching ants), choose 

Select>Save Selection.  In the Save Selection dialog window, type an appropriate  name for your new Alpha Channel in 

the Name field and click OK button 

Make layer thumbnails easier to see in Photoshop: 

 Sometimes you will have small elements on a Layer and will not see your element in the Layers panel. 

 To expand small elements in the Layers Panel to help you see the small element, do the following: 

 Click on the Flyout icon (left figure below) and in the popup menu click on Panel Options. 

 Then in the Layers Panel Options window, click on the Large Thumbnail Size and under the Thumbnail Bounds field 

check the Layer Bounds button (right figure below). 

 
LIGHTROOM TIPS 

Lightroom Classic Updates: 

Lightroom Classic 9.1 was updated on December 10
th

.  As well as some performance improvements, bug fixes and new 

camera/lens support, the Adobe engineering team mainly focused on Catalina (Mac operating system) 

compatibility.There are no feature changes to Lightroom Classic. 

Lightroom (Cloud based) Updates: 

The Lightroom cloud ecosystem was also updated on December 10
th

, with updates for Windows/Mac (3.1) and iOS & 

Android (5.1) mobile phones. In the Share menu, you can now export to a TIFF format. This is especially useful if sending 

to Photoshop for optimal quality. 

Breadcrumb Filter Bar Missing: 

 Just above the filmstrip, you’ll find a variety of information and controls which is called the Breadcrumb bar.  On the 

right-side of the Breadcrumb bar is a Filter bar that can go missing.(shown in figure below). 

 

 To return the Filter bar, click on the word Filter: (red arrow in figure above).  The Filter bar will then reappear as shown 

in figure below. 

 
 

 

https://www.lightroomqueen.com/whats-new-in-lightroom-classic-9-1/#fixes
https://www.lightroomqueen.com/whats-new-in-lightroom-classic-9-1/#cameras
https://www.lightroomqueen.com/whats-new-in-lightroom-classic-9-1/#lenses
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RCC Photo Blog – Stan Fry 
 

Redlands Camera Club Group Members Only 

Are you a member of the Redlands Camera Club? Come and join our new 

Members Only group where you can share images, tips, tricks, offer support or 

insights, ask questions and interact with other members without all the other 

distractions of an open group. Please read the rules and you must be a 

Redlands Camera Club member to join! 

We are up to 70 users and almost 1,100 images on the RCC Photo Blog.  

If you do not already have an account,send an e-mail to signup@rccphotoblog.com and we will get you set up. 

The blog is a great place to get input on your images. Other Members’ images can help you find some inspiration 

(and perhaps some motivation). 

We are working on the image color issue for some images.  When images are submitted they are resized to fit 

different screens.  In this process, they are desaturated a bit.  We don’t know the cause of the problem yet, but are 

working on a solution. 

 

I got tired of sifting through photography sites and blogs trying to find useful learning material.  In response, I 

created pbdigest.com – a curated (sort of) collection of photography articles from over 100 photography blogs.  

Given that this site helps me keep track of useful learning resources, I though club members may benefit too.  I 

would also be interested in any feedback you might have.  Thanks for taking a look and I hope the site is helpful to 

you. 

 

 

 

 

 

 

 

 
Photo 

By 
Dennise Taylor 

 

 

 

 

 

https://www.facebook.com/groups/2521924061368053/?__xts__%5B0%5D=68.ARCMAALkoRBiKV1gSiQlz6tIFwP9hhA0vDx7b_cNQPtCWsrnFMzm43yvMG4XGCLGF8UwN6ingQLl8pIRVLlFRKC-t81BV15gmBA8fWuptNsT85AI8BJu5BBvlHdKIOPq2ehadlUiqXAE25HwAqNDrKmKcreKuQkyCDhfU2Um_PIjoNfzm-yMmxlb27M_n1MbD0VOrODP5y4kS-ZhpNbY2LxPmu3_rYsXSOvN0WdeXQl7Q-2T7MzbQ_OLg2lLhCYKDuqHemuPluGDQDo-X5EDmnmwkePxpl6cQa4AZrRYCNuceCLnaXdyOfA-jhJQJgHljsQCnUyWfkuT29YQzMFPQQcc4w&__tn__=HH-R
http://www.pbdigest.com/
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Announcements 
 

New – Personal Lightroom Coaching with John Williams 
 

Contact John Williams for some over-the-shoulder coaching in photo editing, a great way to learn. Using 

your selected images, John will work with you at your level to improve your understanding of key tools and 

techniques to make the most of your photos. John is a regular contributor of articles on Lightroom and 

Photoshop to the RCC Photogram. Reach John at jhwr@earthlink.net or talk to him at our meetings.  

 

RCC Members: Unique opportunity to make a difference 
Frank Peele, Education/Workshops Chair 

Museum of Redlands 

This newly-established museum needs quality photography of items in its collection, and has asked RCC 

for support. This sounds like a win-win situation, both for the museum and for our members who want 

to develop skills in “product” photography. I envision a workshop to teach the fundamentals, and one or 

more shooting sessions to get into creating great images for the museum’s use. If you’re interested in 

being part of this service to the community, or just want to find out more about the opportunity, shoot 

me an email: educationworkshopsrcc@gmail.com  Thanks, Frank 

____________________________________________________________________________________________________________ 

Film cameras and Lenses Needed  
 
A group of photo-enthusiasts at Riverside Community College needs FILM cameras and lenses to use in 

their studies. If you have such equipment you’re willing to donate to a worthy cause, please contact RCC 

member Constance St Jean and let her know what you have.  

 
Contact her by email at constancestjean@gmail.com 

  

 

Photo 
by 

Rick Strobaugh 
 

 

 

 

 

 

 

 

 

 

 
 

mailto:jhwr@earthlink.net
mailto:educationworkshopsrcc@gmail.com
mailto:constancestjean@gmail.com


~ 13 ~ 
 

 Photogram Editor – Debra Dorothy 

A Note from The Photogram Editor 
 

The theme for the January Photogram is “Characters”. Send me your best pictures taken at 

Renaissance Fair’s, Civil War Reenactment’s, Native American Pow Wow’s and anything 

where people are dressed in costumes and I will include them in the next Photogram.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

                                                                            
 

 

 

 

 

                   
 
 

Photo by Debra Dorothy 
 

mailto:debbiedsd.dorothy@gmail.com 

 

 

mailto:debbiedsd.dorothy@gmail.com

